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1 General Information 

AutoForm Forming R8.0.2 is the second released patch version of AutoForm Forming R8. 

With the AutoForm Forming R8.0.2 patch several significant bugs in AutoForm Forming have 

been fixed. For more detailed information, please refer to section 3 Release Content. 

NOTE: It is mandatory to update front-end and back-end modules in order to ensure mutual 

compatibility! There are no changes except bug fixes in AutoForm-Solver R8.0.2 which 

means that simulation results are identical to those of AutoForm-Solver R8! 

The compatibility of data files between AutoForm R8 and AutoForm R8.0.2 is bi-directional, 

meaning that data files created with AutoForm R8.0.2 can be processed in AutoForm R8 

(and all R8 patch versions) and vice versa. 
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2 Installation Instructions 

IMPORTANT NOTE: It is mandatory to update front-end and back-end modules in order to 

ensure mutual compatibility! 

 
Front-End and Back-End Windows 

Prerequisites 

The Windows patch installer updates a few files of the previously installed AutoForm Forming 

R8. The patch installer will not change any configuration (installation folder, license server 

configuration, etc.).  

NOTE: It is essential that all AutoForm Forming R8 applications are closed before starting 

the patch installation! 

Download of Installation Files 

1. Start AutoForm Forming R8. 

2. Right click on title bar of AutoForm Forming R8 window and select the command Check 

for Updates…. 

 

3. AutoForm Software Updates download page is opened in the internet browser. 

4. Select the link to download AutoForm Forming R8.0.2 Windows 64 bit patch installation 
file. 
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Installation 

1. Download the installation file AutoForm Forming R8.0.2 Patch Installer EN.zip as 

described above. 

2. Log in using an administrator account. 

3. Unzip the installation file. 

4. Execute file AutoForm R8.0.2 Patch.exe. 

5. Select Install in the Welcome dialog. 

6. Depending on your user account control level, you are asked for administrator privileges. 

7. After the patch installation is finished, quit the installer by clicking on the Finish button. 

 
Silent Installer Windows 

Command line for the patch installer: 

msiexec /I "[AF_PATCH].msp" /quiet /passive /qn /norestart 

LIC_HOST="[LIC_SERVER_VAR]" LIC_HOST="[LIC_SERVER_VAR]" 

MAIN_INSTALL_LANG="[ProductLanguage]" REINSTALLMODE="ecmus" 

SINGLE_INSTALL="set" /L*V [TempFolder]debug_patch_R8.0.2.log 

Example: 

msiexec /I "AutoForm Forming R8.0.2 Patch Installer.msp" /quiet /passive /qn /norestart 

LIC_HOST="2375@licenseservername" LIC_HOST="F" MAIN_INSTALL_LANG="1033" 

REINSTALLMODE="ecmus" SINGLE_INSTALL="set" /L*V 

[TempFolder]debug_patch_R8.0.2.log 

 

Back-End Linux 

NOTE: It is essential that all AutoForm Forming R8 applications are closed before starting 

the patch installation! 

Download of Installation Files 

Open AutoForm Updates download page in your internet browser: 

 http://www.autoform.com/en/products/software-updates/ 

1. AutoForm Software Updates download page is opened in the internet browser. 

2. Select the link to download AutoForm R8.0.2 Linux 64 bit patch installation file. 

  

http://www.autoform.com/en/products/software-updates/
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Installation 

1. Download the installation file AFForming_R8_0_2_Remote_Linux64.tar.gz as described 

above. 

2. Login in as root  

3. Create the AutoForm installation directory (in the following /opt/AutoForm/AFplus is 

assumed to be the installation directory, but any directory will do)  

mkdir –p /opt/AutoForm/AFplus  

4. Copy the archive into the AutoForm installation directory:  

cp AFForming_R8_0_2_Remote_Linux64.tar.gz /opt/AutoForm/AFplus  

5. Unpack the archive in the AutoForm installation directory:  

cd /opt/AutoForm/AFplus  

tar zxvf AFForming_R8_0_2_Remote_Linux64.tar.gz 

6. Run the installation script:  

cd R8F/installation ./install [nobody|root] 

For more information see Installation Guide R8. 
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3 Release Content 

New Features 

The version R8.0.2 does not contain any New feature. 

 

Modified Features 

The version R8.0.2 does not contain any Modified feature. 

 

Fixed Bugs 

General  

Restart Simulation Restart simulation wrongly stopped with an error message: "Invalid 

modification of restart simulation input. Operations that occurred 

before the restart point may not be changed. The definition of 

operation X has been modified." 

●     Part to Keep was wrongly re-calculated in Restart Design. 

●     Die Face did a wrong update. 

 

Load & Set Evaluation 

Standard 

● After Load & Set Evaluation Standard Settings button on 

Evaluation Stage turned into red color. 

● After Load & Set Evaluation Standard parameters defined 

as Default wrongly turned into yellow color. 

 

Automatically set 

Standards by New 

Design: Evaluation 

● Application crashed when Evaluation Standard was 

automatically set for a new design. 

● Application crashed when Evaluation Standard was 

automatically set for a new design and Use Evaluation Area 

was activated. 

 

Standard Editor > Layout 

for Discrete Scale 

Discrete Scale Layout for Sheet Results and Geometry Results was 

different. 
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Control Parameters 

Standard > Skid Lines 

Check Radius 

 

Option Abs/Rel was missing for Skid Lines - Check Radius in 

Control Parameters Standard. 

Design Standard > 

Friction Coefficient (Die 

Face - Developed Blank) 

Parameter Friction Coefficient (Die Face - Developed Blank) was 

not used in Forming application (Die Face Stage > Formchk > 

Friction Coefficient). 

 

Application Menu > 

Open... > Multiple Files 

Loading multiple designs at once could have caused: 

●     Endless loop for loading one design. 

●     Application crash. 

 

Redo last action on Strip 

> Layout 

● Application crashed when Redo last action was done to 

Delete Strip > Layout. 

● Application crashed when Redo last action was done set 

Used Variant on Strip > Layout. 

● Application crashed when Redo last action was done to 

Delete Strip > Layout > Variants. 

 

Section on Part 

Geometry 

Application crashed when Section was defined on Part Geometry. 

Part  

Replace Part Geometry After Replace... Part Geometry outer part boundary was wrongly 

defined as hole or cutout.   

 

Formcheck Material Files with Forming Limit Curve defined as Table causes 

wrong Formcheck results. 

 

Import > STEP File A certain STEP file could not be imported. 

 

Import >  

CATIA V5-6R2019 

 

CATPart files of CATIA V5-6R2019 could not be imported. 
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Material & Lubrication  

Expiry Date of 

Lubrication Files 

Now, material files can be encrypted using 

AFProtectLubrication.exe and the expiration date as parameter (-

date YYYY MM DD). 

 

Compensator  

Non Rigid Registration 

with Symmetry condition 

Symmetry condition was not correctly considered for Non Rigid 

Registration. Therefore, when evaluating Displacement from 

Reference, even for elements adjacent to symmetry plane, showed 

wrongly displacement normal to Symmetry plane (Displ Ref Y-Dir or 

Displ Ref X-Dir). 

 

Plan  

Trim Plan Editor > Draw-

In 

Application crashed for some rare cases when Draw-In curve was 

edited and modification was confirmed with OK. 

 

Pressline View Application crashed for some rare cases when Pressline View was 

activated on Plan Stage. 

 

Production Page > 

Delete Multiple 

Operations 

 

Application crashed when multiple Operations were selected and 

Delete Operation was chosen. 

 

Die Face  

Trim Plan & Symmetrical 

Parts 

For some rare cases of symmetrical parts... 

● Draw-in curve was not correctly taken over from Trim Plan 

to Trimcheck. 

● Editing Trim Plan (e.g. Delete Connectors) caused 

additional wrong operation labels. 

 

Modify > Trim Application crashed when a Trim feature (which was listed after 2 

Preform features) was deleted or applied. 
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Modify > Gainer Application crashed when a Gainer feature was added. 

 

Trimchk Trim Curve was not developed, but projected due to wrong internal 

data structure. 

 

Process  

Stepbead > Reduction 

Strategy: 0 

Application crashed in one specific example when Reduction 

Strategy parameter was set to 0 for Profile Type Step. 

 

Drawbead > Drawbead 

Curve 

Application crashed when Drawbead Curve was set to Dependent... 

on an Imported (Part > Import > Generic) curve without having 

defined Material Thickness (Part Stage > Material). 

 

Fold Away Tools & 

Hotforming 

 

In Hotforming set-ups Fold away at Distance was wrongly defined. 

Lube > Lubrication 

Conditions 

One tool was missing in the Tools list when setting up separate 

Lubrication Conditions for each tool (Separate for Each Tool of D-

20). 

 

Import Motion Curve Motion Curve was wrongly imported and converted to a non-valid 

Solver input. 

 

Evaluation  

Top/Bottom Layer Top/Bottom Layer evaluation did not work for Curvature result 

variables. 

 

Mat Views Application crashed when Mat View was added in base design, 

dependent restart design was simulated and finally Mat View was 

activated. 
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Remote Computing  

Simulation Stage > 

Sigma Page > Log 

Deactivated Log button (since log was empty) was wrongly 

activated after Extract Realization. 

 

Re-connect to Sigma 

Job running on Remote 

Computer 

Re-connect from AutoForm Forming application on local computer 

to Sigma Job  on remote computer failed since AutoForm Forming 

application was used once before without network connection. 

 

Solver  

Hotforming & 3D Heat 

Conduction 

For the rare case of combining "Cycles > User Defined", "Opening 

of Tools > Accurate Opening..." and "Support > Lock during 

Opening" Solver stopped with warning. 

Note: To repair an existing design (< Forming R8.0.2) open the 

design and save it with Save as...! 

 

TriboForm Plug-In & 

Patchwork Blanks 

 

Using advanced friction model of TriboForm Plug-In caused 

abnormal termination of FormingSolver. 

 

Material File caused 

FormingSovler 

termination 

One specific material card (aluminium) caused termination of 

FormingSolver with error message: 

Error in material routine of elastic-plastic shell: Material integration 

failed (No convergence in closest point iteration). Please check the 

material descriptions. Hardening curve must be given in logarithmic 

plastic strain and true stress. Measured hardening curves should be 

smoothed before use. 

 

Trimline Optimization  

Delete Cracked 

Elements 

"Delete Cracked Elements" could not be activated when running a 

Trimline Optimization. 

 

Input Modification sets 

Max Deviation to 0 

Some input modifications set Max Deviation value to 0.  

Application crashed when Max Deviation value was edited. 
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Report Manager  

Strip > Layout > Shape 2 Shape 2 of Strip > Layout was missing in Report Manager (Part > 

Strip Concept > Weights And Prices). 

 

Sigma  

Tooltips by mouse over When evaluation Sigma results (Histogram, Scatter Plot, Influence 

Plot...) tooltips by mouse over were shown for too short period. 

 

Cp (noise variation) of 

Displacement from 

Reference 

 

3D sheet rendering for Cp (noise variation) of Displacement from 

Reference was not smoothed. 

 

QuickLink  

Share via QuickLink & 

Special characters in 

Design File Name 

 

Generated .zip files got wrong name when design file name 

contained special characters. 

Share via QuickLink > 

Rollers (for Hemming) 

● Identification (GUID) of Hemming Rollers was missing. 

● Conus Angle was wrongly given in radian. Now, it is in 

degrees. 

 

Progressive Dies  

Station Labels for 

Progressive Dies 

With the entry "Show Operation Boundaries and Labels" in 

Application Toolbar > Annotations > Annotation Options Labels for 

each Station are displayed in 3D View if Pressline View is activated. 

 

Trim Plan Editor & 

Tipping direction 

Trim Plan Editor used Part Tipping (Part Stage > Tip Page). 

Now, Trim Plan Editor uses Strip Tipping (Part Stage > Strip Page). 

 

Blank Plan & Symmetry Activating Use Symmetry in Blank Plan Editor caused wrong 

visualization of strip alongside symmetry plan. 
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Plan Stage > Blank 

Outline 

Blank Outline was duplicated after adding Custom Press and using 

Autoplan. 

 

Plan Stage > Blank 

Outline 

For some rare cases Scrap Pieces were wrongly derived from 

Developed Part Outline (Part Stage > Strip Page). 

 

Evaluation Stage > 

Forces > Tooltip 

Tooltip for Pilot Forces on Evaluation Stage > Forces were wrongly 

shown in kN. 

Now, Pilot Forces are correctly shown in N. 

 

OP Boundary in 

Pressline View with 

Symmetry 

 

OP Boundary was only shown half  in case of symmetry (on the 

opposite side of the sheet). 

Pilot Group Pilot Groups, dependent on Strip (Base Points > Dependent... > 

Strip...), were not updated when Strip was changed.  

 

Cutting Tools for Pilot 

Holes with Symmetry 

(Half Input, Symmetrical) 

Each single Pilot Hole (on Plan Stage) has got 2 Cutting Tools (on 

Process Stage) which caused a Solver termination. 

Now, symmetry (Half Input, Symmetrical) is not doubling anymore 

cutting tools on Process Stage. 

 

Copy Pilot Group To All 

Other Stations with 

Symmetry 

 

Copied Pilots were wrongly oriented on one symmetry side for 

Stations with different tippi 

Pilot orientation after 

Tipping modification 

 

When Tipping of an operation was changed Pilots of this operation 

were also changed and did not anymore fit to strip. 

Step Beads Step Beads were wrongly oriented in case of Progressive Dies. 
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